Document Manager
This is a very powerful tool in MYOB EXO Business, as it allows you to keep copies of the documents you
have sent to each Debtor and Creditor. These could be anything from a .GIF to an .AVI file, or anything that
is recognised by Windows applications. You can also easily create mail merge templates with the customer
or supplier name and address details. You can even personalise the document to suit your requirements.

Accessing the Document Manager
There are two ways of accessing the Document Manager to create and manage your documents:


Select Document Manager from the Utilities menu.



On the Documents tab of an account (see page 140), click the

button.

Both of the methods will open the Document Manager window:

Entering a query into the search key will search for all documents regardless of the Creditor or Debtor.
Double Click on any one of these documents to edit it in the document manager window.
Click

New to create a new document using the Document Manager (see page 527).

Grid Field definitions
The grid has a header for each column, these are detailed in the table below:
Field

Description

Seqno

A unique identifier for records in tables.

Savedate

The date of the last edit that require a save.

Docdate

The date the document was attached to the account.

525

MYOB EXO Business User Guide
Module

The module of MYOB EXO Business. This will default to the ledger that you are
currently in (Debtors or Creditors).

Refcode

Any internal reference text for the document.

Doccode

Any internal document code for the document.

Description

A description of the document.

Importing and Exporting Documents
Debtor/Creditor Account > Documents Tab >

and

Importing a Document
To import a document:
1. From the Documents tab inside the Master Account, click the Import button .
2. Select the appropriate document / file and click Open, you will now see the following window:

To reduce the size of the database, MYOB recommends keeping this file as a link only.
3. Click OK and the Document Manager window (see page 527) opens, prompting for details on the
recently imported document.
If you choose to import this document as a link, this is labelled in the Document Manager window:

Exporting a Document
To export a document:
1. From the Documents tab inside the Master Account, click the Export button .
2. Select the destination directory for this document and click Save. A window will open confirming
the successful export, click OK to complete the process.
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Document Manager Window
Use Import, Export and View to manage documents. Document date, File name and Source path will be
added automatically when a document is imported.
The following table describes the fields in the Document Manager window.

This window allows you to edit or create fields to the new/edited document.

Field definitions
Field

Description

Module

The module of MYOB EXO Business that the document applies to. This will default
to the ledger that you are currently in (Debtors or Creditors).

Account

The Debtor or Creditor account that the document is attached to.

Reference

Any internal reference text for the document.

Document Code

Any internal document code for the document.

Description

A description of the document.

This will help you to identify
the document when you go
back to view it at a later
date.
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Document date

The date the document was attached to the account. This field will be greyed out
and you will not be able to edit it. Once you have selected the document that you
wish to import, MYOB EXO Business will insert the current system date and time
that this document was imported.

File Name

The filename of the attached document. This field is also greyed out and will
display the original name of the document that you selected to import. Once
again you cannot edit this field.

Source Path

This will display the source path from which this document was selected. This is
also greyed out and you will not be able to edit this field. Once you have added
these in, click “Save” to save the document.

Buttons
Change Document

Import a new document, replacing the original document, i.e. the existing
document will no longer be attached. This function can also be accessed by
clicking the toolbar button.

Export

Export a document stored in the MYOB EXO Business database to a separate
standalone file. This function can also be accessed by clicking the toolbar
button.

Open

Opens the document in the default viewer. This function can also be accessed by
clicking the
toolbar button.
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Bulk Sending Documents
The Mailshot function lets you bulk send documents to Debtors, Creditors or Contacts by print and/or
email. The Mailshot function is available from the following windows:


Debtor Statements (see page 396)



Invoice Batch Printing (see page 392)



Creditor Remittance Advices (see page 341)



Direct Debits (see page 493)



Campaign Waves (requires EXO Business CRM)

Specify the following details:
Detail

Description

Printer URL

Select the printer to use for those documents that are to be printed
out.

Email Mode

Specify how emails should be sent. The following options are
available:


Disabled - Emails will not be sent.



EXO SMTP - Emails will be sent via SMTP using the EXO
Business Email Sender (see page 44). This is better for sending
large batches of emails.



Default Email Client - Emails will be sent using the user’s
default email software. This is suitable for smaller batches of
emails.
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Email Body as plain text

Tick this option to restrict the body of emails to plain text, rather than
HTML.

Confirm each email on
screen

Tick this option to display a confirmation message before sending each
email, or leave it blank to send emails automatically.

Save copy of sent email to
documents

This option only appears when sending a mailshot from a campaign
wave in EXO Business CRM. Tick this option to save a copy of the sent
email to the Docs tab of each Contact that the mailshot is sent to.
Note: A History Note is always created for each Contact when a
mailshot is sent. If this option is ticked, the email is saved in
addition to the History Note.

CLE File

Specify the Clarity email template to use for email communications.

CLM File

Specify the Clarity mail merge template to use for printed documents.

Attachments

Specify any attachments to be sent with emails.

The bottom section displays all Debtors, Creditors or Contacts who will be sent communications by the
mailshot. Double-click on a Debtor, Creditor or Contact to drill to that record.
Tick or clear the Email and Print boxes for each Debtor to specify how statements will be sent to them (or
use the toolbar buttons to check all Email and/or Print boxes). The default settings for these options are
determined by the following properties:


For Debtor Statements, the Statement Delivery setting on the Debtors Details 2 tab (see page 94).



For Direct Credit remittance advice, the Remittance Method setting on the Creditors Details 2 tab
(see page 108).



For Direct Debit remittance advice, the Advice notification settings on the Debtors Details 2 tab
(see page 94). (These settings are only available when the Default payment type is set to
“D/DEBIT”.)

The default value for the Primary Email is determined from the following properties:


If a Statement Contact (Debtors) or Remittance Contact (Creditors) is specified for the
Debtor/Creditor, this Contact’s email address is used; otherwise



if a default Contact has been set on the Contacts tab for the Debtor/Creditor, this Contact’s email
address is used; otherwise



the company email address on the Details 1 tab of the Debtor/Creditor is used.

Email addresses can be manually edited if necessary.
Note: When sending a mailshot to Contacts, if any lines are highlighted in grey, this means that the
highlighted Contacts have the Opt-Out eMarketing flag ticked. These Contacts will not be processed
in the mailshot, regardless of whether or not the Email and Print boxes are ticked.
When all options are set, click the Go button to start the mailshot.
When running a mailshot from the Invoice Batch Printing window, you are given the option of collating
invoices for Debtor account - in this case, a single email is sent to each Debtor, with all invoices for that
Debtor attached; otherwise each invoice will be emailed separately. The # Invoices column displays how
many invoices there are for each Debtor (this column is only available when running a mailshot from the
Invoice Batch Printing window).
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Note: If the attachments to a collated email exceed a size limit (set by the Batch Invoice Mailshot
Attachment Size Limit profile setting), the invoices will be split over multiple emails.
As statements are sent, the Done box for each account is ticked. The Pause and Stop buttons allow the
mailshot to be suspended or cancelled before it is complete.

Creating Merge Letters
By creating a template document in Rich Text Format you can merge customer details into another .RTF file
for distribution. Template files are expected to have TP_*.RTF
To create a merge letter:
1. Open a Debtor or Creditor account and go to the Documents tab.
2. Open the Select Clarity Merge Letter window by clicking the
template from the list.

button. Choose the appropriate
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You should already have a “form letter” prepared with the database fields you wish to insert into
the letter defined. An example is given below.

3. You will be asked to choose the original Template file and destination for the output file. Choose
these and select OK.
4. Once the document has been created, MYOB EXO Business will open it up automatically.

5. On closing this document, MYOB EXO Business allows you to put in the referencing information for
the document before you save it.
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Merging Account Data with an Existing Template
To create a form letter by merging account data with a template:
1. Open a Debtor or Creditor account and go to the Documents tab.
2. Click the

button.

3. Choose a predefined template file using the ellipsis button [...] then click OK.

4. Edit the document in the default editor.
5. Save the changes to your edits and click Yes on the Add to account documents dialog.

From this point the Document Manager window opens, prompting the document descriptive fields to be
completed.
This is a very powerful tool in MYOB EXO Business, as it allows you to keep copies of the documents you
have sent to each Debtor and Creditor. These could be anything from a .GIF to an .AVI file, or anything that
is recognised by Windows applications. You can also easily create mail merge templates with the customer
or supplier name and address details. You can even personalise the document to suit your requirements.
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MYOB EXO Business contains various methods of obtaining reports, including tools that allow the user to
create their own GL reports, customise forms and create other general purpose reports.
Reports and reporting options are all accessed from the Reports menu. This menu contains the following
options:
Option

Meaning

Dashboard

Opens the Dashboard (see page 539), which displays a configurable view
of multiple summary reports.

Clarity Report Browser

Opens the Clarity Report Browser (see page 537), from where you can
select and run reports from various categories.

Clarity Report Designer

Open the Clarity Report Designer (see page 539), which is a utility that lets
you customise reports and forms, or create entirely new ones.

Analytics

Opens the EXO Business Analytics module (see page 549), which takes
“snapshots” of business activity, allowing viewing of historic key
performance indicators such as stock and sales activity.

Debtors Reports

Sub-menu containing a selection of Debtors reports.

Creditors Reports

Sub-menu containing a selection of Creditors reports.

Sales Reports

Sub-menu containing a selection of Sales reports, as well as the Sale
Analysis Designer

Stock Reports

Sub-menu containing a selection of Stock reports.

Purchases Reports

Sub-menu containing a selection of Purchases reports.

General Ledger Reports

Sub-menu containing:


A selection of General Ledger reports, including the Chart of
Accounts.



Options to set up special GL Reports using the GL Report Writer
(see page 244), and then run them.



Options to set up and run GL Report Batches (see page 258).

Tax Reports

Sub-menu containing various Tax and Tax Return reports (see page 503),
as well as options to edit previous Tax Returns.

Currency Reports

Sub-menu containing a selection of Currency Exchange Rate reports.

Other Reports

Sub-menu containing reports on the MYOB EXO Business system.

Shift Report

Opens a window for running and printing Shift Reports to be used with the
POS system.

Note: This is the default layout for the Reports menu. This menu can be customised using the Menu
Designer (see page 75); in this case, the available menu options may not match the options listed
here.
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Running a Report
Select a report to run from the Report menu or from the Clarity Report Browser (see page 537). After
running the report, you must enter any report parameters required. You can then output the report to the
required destination in the required format.

Specifying Report Parameters
If no parameters are required, the report is generated immediately. A report preview (see page 535) is
displayed, which can then be printed.
Many reports use a standard Clarity Report Parameters window for gathering parameters (some or all of
which may be optional):

The exact parameters available differ from report to report, but the layout of the Clarity Report Parameters
window and the available options are common to all reports that use the window.
Note: Some reports use a more complex custom window for gathering parameters. These windows
are specific to their report.
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Viewing, Printing and Exporting Reports
Once the required parameters have been entered, the report can be generated and then output to a
variety of destinations. The Clarity Report Parameters window offers the following options are available
from its File menu or toolbar:
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Print - generates the report and prints it to the selected printer.



Preview - Generates the report and displays it in an onscreen viewer. The report can be printed
directly from the preview, or you can close the preview to return to the Clarity Report Parameters
window.



Export to File - Generates the report, then displays a Print to File window, allowing you to select
the file format to export the report to.

Reporting


View Grid - Displays a grid containing the data that the report is generated from. This view is also
available on the Grid tab of the Preview window.



Email Attachment - Generates the report, then attaches it to a new email as a PDF. The default
email client is used for composing and sending the email.



Export to XLS Report - Generates the report as a Microsoft Excel report, then opens it in Excel.



Note: When using Excel 2010, the report will open in Protected View mode. To prevent this from
happening, open the Trust Center in Excel and add the EXO Business temporary directory as a
Trusted Location. The temporary directory is specified by the Directory location for temporary files
Computer-level profile setting.
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Clarity Report Browser
Reports > Clarity Report Browser
The Clarity Report Browser displays a structured list of all available reports. Reports can be run directly
from the browser, or they can be opened for editing in the Clarity Report Designer.

Running and Editing Reports
If the Show Preview button is toggled on, clicking on a report displays a review of the report on the right of
the window.
Select a report and click Run Report to run the report (see page 535).
Select a report and click Edit to open the report for editing or customisation in the Clarity Report Designer
(see page 539).

Sorting Reports
EXO Business looks for Clarity reports and forms in the directories specified by the Computer Profile
settings Directory for Custom Clarity Forms(.CLR,.CLF and .FMT) and Directory for Standard Clarity
Forms(.CLR,.CLF and .FMT). All Reports detected by MYOB EXO Business are displayed in the browser,
sorted into categories.
Information on the report’s category is stored in the file properties of each report file. If this information is
not present for a report file, the report will be classified into the “No Category” category. Right-click on a
report and select Properties to view that report’s file properties.
Note: EXO Business keeps a record of all standard reports that are available by default. Selecting File
> Reclassify All Reports sorts all known reports that are missing their classification data into the
appropriate categories.
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Clarity Report Designer
Reports > Clarity Report Designer
The Clarity Report Designer is a utility for creating and editing reports and forms in MYOB EXO Business. It
features a wide range of options for drawing in data from EXO Business database tables, then sorting and
presenting the information on a report whose appearance can be completely customised.
Note: See the MYOB EXO Business Clarity User Guide for full details on the use of the Clarity Report
Designer.
Existing reports can be opened in the Clarity Report Designer by selecting them on the Clarity Report
Browser (see page 537) and clicking Edit. Alternatively, you can select File > Open in the Clarity Report
Designer and browse to find the .CLR or .CLF file for the report or form you want to edit.
Note: The directories that MYOB EXO Business looks in for Clarity reports are specified by the
Computer Profile settings Directory location for custom Clarity forms (.CLR,.CLF and .FMT) and
Directory location for standard Clarity forms.

Dashboards
Dashboard Interfaces
Reports > Dashboards
Dashboards are customisable displays showing one or more “widgets”. Widgets are small, self-contained
information panes; in many cases they are summary reports, making the Dashboard an at-a-glance
overview of the entire MYOB EXO Business system. Other functions can be added as widgets however,
including external applications.
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The default Business Flow Menus (see page 78) of several EXO Business modules are composed of
Dashboard interfaces; this allows them to be customised by each user, and also means that they can display
current system data on the main menu.
Data on Dashboard reports can be printed or exported using the options on each widget’s toolbar.

Laying out Dashboards
To add a widget to the Dashboard, click the Add Widgets button (
). This opens the My Widgets List
window, where you can select the widgets to appear on the Dashboard:

Widgets only appear in this menu if they have been added to the relevant drop down menu using the Drop
Down Menu Designer (see page 75). Once widgets have been added on this list, they can be enabled or
disabled using the Setup Widgets dropdown menu (
).
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To change the layout of the Dashboard:


Drag widgets around to re-order them.



Click and drag the border of a widget to re-size it.



Use the Zoom Setting options on a widget’s toolbar to make that widget fit to its frame:



Click the

button to reset the layout, organising all widgets into tiles the same size.

Click Tools > Save Layout to save the current layout of the Dashboard.
Note: Dashboard layouts can be locked for each EXO Business module, so that widgets cannot be
added, removed or re-arranged and the Dashboard toolbar is hidden. To lock a Dashboard layout,
enable the Lock dashboards User-level profile for the relevant module.

Setting up Dashboard Widgets
Dashboards are customisable displays showing one or more information panes called “widgets”. To create
a new widget:
1. Open EXO Business Config and go to the Admin > Dashboards > Setup Widgets or Staff > Menus >
Setup Widgets section.
Note: A Setup Widgets menu item is also available to be added to the menus for other modules.
2. Click the New button.
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3. Enter a name for the widget.
4. Select the Refresh Frequency, which determines how often the data in report is automatically
refreshed.
5. Select which EXO Business module(s) this widget should be available for. Choose from:


<All>



EXO Business



EXO Job Costing



EXO Business Analytics



EXO Business CRM



EXO Accountant’s Assistant
Note: Checklist widgets can only be made available for the EXO Accountant’s Assistant.

6. Widgets are not available to users until they have been added to their dropdown menus. You can
add the widget to users’ menus automatically by selecting one or more from the Menu
Assignments dropdown. Widgets can be manually added to menus later using the Drop Down
Menu Designer (see page 75).
7. Select a Widget Type:


Select “Clarity Report” to create a widget that displays a Clarity report.



Select “URL” to create a widget that displays the target of a URL, e.g. a web page or a local
file.



Select “Pivot Table” to create a widget that displays data in a pivot table.



Select “Grid” to create a widget that displays data in a standard ExoGrid (see page 10).



Select “Checklist” to create a widget that displays a structured list of steps that must be
performed and checked off.



Select “Form Widget” to create one of the pre-defined widgets installed with the EXO
Business system.



Note: Once a widget is saved, its Widget Type cannot be changed.

8. Specify what information the widget should display:


If you are creating a Clarity widget, click the
button to select a report file. Once a
report is selected, this button opens a window to set any necessary report parameters.



If you are creating a URL widget, enter the URL to display into the URL field.



If you are creating a Pivot widget or Grid widget, enter a SQL statement to select the data
to display into the SQL field.



If you are creating a Checklist widget, the items on the list must be set up on the Checklist
Setup tab (see page 543).



If you are creating a Form widget, select the Form Type, then set details on the Customize
Widget tab.

9. For Clarity widgets, select Default Zoom Settings, which determine how large the report appears
inside its frame.
10. Click Save.
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Once a widget has been created, it is not available on dashboard interfaces until it has been added to one
or more drop down menus using the Drop Down Menu Designer (see page 75). Add the widget to the
Widgets section of all menus for all users who should be able to use it.

Configuring Checklist Widgets
Checklist widgets display a structured list of steps, or “nodes”. Each node is a separate item that can be
checked off the list; nodes can be a simple note to the user, or they can link to an EXO Business menu
procedure, which will open on the checklist widget display:

Buttons are available at the bottom of the checklist tree. Selecting a node on the tree and clicking these
buttons changes the node’s icon to indicate its status:





- Not Started
- In Progress
- Complete
- Requires Review
Note: There is no button for the Requires Review status; however, it can be set by a stored
procedure attached to the node (see page 545).

Node statuses can also be changed by right-clicking on a node. When right-clicking on a parent node,
options to set the statuses of all child nodes are available.
When “Checklist” is selected for the Widget Type, a Checklist Setup tab becomes available:
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To set up a checklist widget, add nodes using one of the following methods:



To add a blank node, click the New Node button.
To add a node that links to an EXO Business menu procedure, drag the procedure from the
Procedures list onto the checklist.

In either case, the Checklist Node Edit window appears. Enter details for the node and click OK.

Field

Description

Procedure

If the node links to an EXO Business menu procedure, the procedure’s name is
displayed here.

Caption

Enter a name for the node. This name will appear on the checklist widget when it
appears on a dashboard.

Parameters

For procedures that require extra parameters, e.g. Run Clarity Report or Add
Existing Widget, specify the parameters here.

Help Text

Enter a short description for the node here, explaining what its purpose is, or
giving instructions on how to use it. This text will appear at the bottom of the
checklist display when the button is clicked.
Note: Any text that starts with www. or http:// will be displayed as a
clickable hyperlink.

Field Name

The statuses of all nodes are stored in the EXO Business database, in the table
specified by the Checklist Status Table property on the Checklist Setup tab. The
status for this node will be stored in the field you specify here. Once set, the field
name cannot be changed.
Note: Field names must be unique - if you enter a field name that is the
same as another node’s field name, it will be prefixed with a number to
make it unique, e.g. FIELD_1. If this node is deleted, the field will be
removed from the database.
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Status
Validation
Stored Proc
Name

The node’s status is usually controlled by the buttons at the bottom of the
checklist widget; however, it is possible to use a custom stored procedure to set
the node’s status. This property specifies a stored procedure that will be run
when the checklist is loaded or refreshed, when the node is clicked on, or when its
status is manually changed to “Complete”. This procedure must take in the
parameters @CONTEXTID and @NODESTATUS, and return a new @NODESTATUS
value, which must be one of:


-1 = Do nothing



0 = Set the node’s status to “Not Started”



1 = Set the node’s status to “In Progress”



2 = Set the node’s status to “Complete”



3 = Set the node’s status to “Requires Review”



4 = Hide the node and any sub-nodes below it

If the stored procedure name you enter here does not already exist, a default
procedure with the correct inputs and outputs will be created when the table is
saved (checklist procedures are automatically prefixed with “CL_”).
Expanded By
Default

If this box is ticked, then all subnodes under this node will be displayed by default;
if not, the node will be collapsed by default, so that its subnodes will be hidden
until the + icon next to the node is clicked.

Subnodes can be added under any node (including other subnodes). Select the parent node or subnode,
and then click New Subnode or drag a procedure from the Procedures list onto the parent node.

Editing Nodes
Once added, nodes and subnodes can be edited by double-clicking on them or by selecting them and
clicking the Edit Node button. It is also possible to re-order nodes and subnodes by dragging them drag
them into a new position, or by using the Move Up and Move Down buttons.
Select a node and click Delete Node or press DELETE to remove that node and any sub-nodes underneath it.

Storing Checklist Node Statuses
The Checklist Status Table property on the Checklist Setup tab specifies the name of the table in the EXO
Business database that will store the individual statuses of each node in the checklist. The table name you
enter here must be unique; it will be created when the table is saved (checklist tables are automatically
prefixed with “CL_”). Once set, the table name cannot be changed. The table contains a field for each node
in the checklist - field names for each are specified by the Field Name property on the Checklist Node Edit
window.
Note: If a checklist widget is deleted, a message appears asking the user if they also want to delete
the associated table as well as any associated stored procedures.

Context-Specific Checklists
Checklists appearing in the EXO Accountant’s Assistant can be made context-specific to a particular period.
A context-specific checklist saves the status of all nodes separately for each period; when a period is
selected from the Financial Period dropdown on the EXO Accountant’s Assistant, the checklist updates to
show the node statuses for that period.
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Select an option from the Context dropdown at the top of the Checklist Setup tab:






None
GL Period
Debtor Period
Creditor Period
Stock Period

If “None” is selected, the checklist widget will not be context-specific; otherwise it will be specific to the
period for the selected ledger. When a checklist is context-specific, the table that stores checklist node
statuses contains a separate line for each period.

Saving and Loading Widgets
Widgets can be saved to a file by clicking the Save As button on the Setup Widgets window toolbar (
Widgets are saved as a file with the .WDG extension. Widget files can then be loaded into the Setup
Widgets window by clicking the Load button (
).

).

Restricting SQL Keywords in Widgets
Pivot and Grid widgets have a SQL tab, where the SQL statement that selects the data to display can be
edited. To preserve the security and integrity of the system, profile settings (see page 70) are available to
restrict what can be entered on the SQL tab:


Edit Pivot Widget SQL at runtime - this User-level profile setting determines whether or not the
SQL tab is displayed. If it is disabled, the SQL tab is not available.



Restrict Widget SQL - if this User-level profile setting is enabled, the user will not be allowed to
enter certain SQL keywords on the SQL tab.



Widget SQL reserved words List - this Company-level profile setting specifies the keywords that are
disallowed. By default, the keywords DROP, INSERT, DELETE, UPDATE, TRUNCATE, MODIFY, and
ALTER are disallowed.

Customising Dashboard Interfaces
A number of options are available for customising the layout of widgets on dashboard interfaces (see page
539).

Selecting Widgets to Display
Users can select the widgets to display on a tab using the
and
buttons. Which widgets are
available for selection is determined by the staff member’s dropdown menu definition, as set up in EXO
Business Config (see page 75).
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To add a widget to the menu (and therefore make it available for selection in the interface), drag the Add
Widget item to menu. When adding this item to a menu, the Menu Item window that appears lets you
choose the specific widget to add:

Once added, the widget does not actually appear in the dropdown menu; instead, it becomes available for
selection when clicking the
button.
Note: Having the availability of widgets controlled by menu definitions allows for an additional level
of security; users have access to only those Dashboard widgets that have been added to their menu.

Arranging Widgets
Dashboards widgets can be arranged by dragging and docking. When dragging one widget onto another, a
cross-shaped docking control appears:
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The five sections of the docking control are used to place the widget being docked, e.g. to dock the widget
being dragged to the right of the widget it is being dragged onto, move the mouse pointer over the right
section and release the mouse button. Selecting the centre section of the docking control docks the widget
onto a sub-tab of the target widget:

Clicking the

button resets the layout, organising all widgets into tiles the same size.

Saving Widget Layouts
Click the button to save the current arrangement of widgets as a “layout”. Previously saved layouts are
available in the Layouts combo box at the left of the window.
Note: In EXO Business Analytics (see page 549), the layout of widgets on the tabs is saved for each
snapshot.
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EXO Business Analytics
EXO Business Analytics is a separate module that presents a customisable overview of the organization’s
business status. It is intended for use by management to monitor business performance. EXO Business
Analytics extracts data from various sources in the MYOB EXO Business system and then displays it in a
consolidated format. This allows managers to quickly get a complete picture of the entire business.

EXO Business Analytics takes data snapshots at regular intervals. Use the arrow buttons to navigate
between snapshots, or select a specific snapshot from the dropdown menu on the right.
Click the
Click the

button on any tab to re-calculate the figures for the currently selected snapshot.
button on any tab to refresh the display.

Note: The Computer-level profile settings Recalculate and Refresh Analytics on Startup and
Recalculate and Refresh Analytics every 15 mins when loaded can be used to automate the process
of taking and refreshing data snapshots.
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The tabs on EXO Business Analytics are fully customisable. Each tab displays a collection of Dashboard
widgets (see page 539).
Note: Tabs can be hidden from view on a per-user basis by configuring the Hide tabs in EXO
Analytics User-level profile setting.
Note: Two optional custom tabs can be defined by specifying values for the one or both of the
Analytics custom tab 1 caption and Analytics custom tab 2 caption User-level profile settings (if no
captions are specified, the custom tabs do not appear).
EXO Business Analytics allows drill down access to the following screens:


Debtor Account Details screen



Creditor Account Details screen



General Ledger Account Details screen



Stock Item screen



Sales Order



Purchase Orders



Job Costing

All screens are read-only when accessed from EXO Business Analytics.

System Widgets
The following system widgets specific to EXO Business Analytics are available:
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Sales Summary (see page 551)



Invoice List (Classic) (see page 552)



Orders List (Classic) (see page 552)



Stock Summary (see page 553)

Reporting

Sales Summary

This widget displays the sales performance of the business. The Run Rate figures indicates what the
business is doing on a daily basis (having made an allowance for the weighting applied to each day in the
Period Day Plan Setup (see page 557)) and what the business must achieve (also on a weighted basis) to
reach its period budget.
The report uses colour to indicate whether the business is ahead of (green) or behind (red) the budget.
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Invoice List (Classic)

This widget allows users to search for Debtors Invoices. For example, by setting the expected minimum and
maximum margins, users can quickly locate invoices that fall outside the expected range. This range may
include stock items that are over-discounted or that have a cost that is greater than expected.
To search for invoices, check the appropriate boxes for the filters to use, then select details to filter by. Click
the Run button to return all invoices that match the selected criteria.

Orders List (Classic)

This widget allows users to search for Sales Orders. The list of orders can be filtered by Period, Account
Group, Sales Person and Branch Name.
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Stock Summary

This widget displays the valuation of stock by location. Users can select a location, and obtain a stock list by
a stock item, for the selected location.
The Show only Inactive Stock option displays a list of stock items that have been set to the Inactive status
(by clearing the Active tick box on the Stock Item Details window (see page 152)). Stock items are listed
only if the item quantity is greater than zero. Drilling down provides a detailed list showing the locations of
the inactive stock.
The Annualised Stock Turn KPI calculates the stock turn based on the current cost of sales on a period-todate basis, using the current closing stock level. The KPI then converts this into an annualised estimate of
current stock turn.

Setting up EXO Business Analytics
The EXO Business Analytics module’s Setup menu contains options that define the Financial Period. A
Financial Period is made up of a financial year, which in turn is made up of periods/months (usually 12).
Months are made up of days. Days can be workdays or non-workdays and can have a weighting applied to
them. This weighting affects the run rates (a run rate is the amount of daily sales achieved to date or
required to reach the monthly sales target).
The following setup windows are available from the Setup menu:


Preferences (see page 553)



Sales Years (see page 555)



Months (see page 556)



Budget (see page 556)



Day Plan (see page 557)

These setup options are also available in EXO Business Config (see page 52) at Admin > Analytics.

553

MYOB EXO Business User Guide

Preferences
EXO Business Analytics > Setup > Setup Info
The options on this window are read-only in EXO Business Analytics and are displayed for informational
purposes. To set the values of these options, use EXO Business Config.

Recalculate report on this computer every 15 mins Enable this option to receive the most up-to-date
information every 15 minutes. Ideally, in a network situation, this option should be selected by only one
user, to avoid load on the network. Any other users should click the Refresh button on the main EXO
Business Analytics window to view the latest information.
Stock Valuation Method Determines the stock values for the stock in the Stock tab. Select the valuation
method that is most useful for decision-making.
KPI Select whether or not to display the following Key Performance Indicators:


Annualised Stockturn, displayed on the Stock tab.



Average Invoice Age, displayed on the Finance tab.



Sales GP percentages, displayed on the Sales and Orders tab. (If this option is disabled, these values
display “N/A”.)

Exclude Quotes from Sales Orders Enabling this option removes quotes from the Sales Today numbers and
includes them when the quote is converted to a sales order. This is only applicable where the system is
using extended sales order statuses.
Use PostTime to Calculate Sales Enabling this option means that EXO Business Analytics will calculate sales
from the transaction table based on when the transaction has been posted as opposed to the transaction
date entered by the user.
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Sales Years
EXO Business Analytics > Setup > Setup Years

The Sales Year Setup window defines Financial Years. Click the New button is to establish a new Financial
Year or double-click on an existing year to edit it.

The Name can be changed to something more appropriate if necessary, and Start and End dates for the
beginning and end of the year can be changed.
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If the Calendar Period option is ticked, then months for this sales year will be set up according to the
calendar year. If the option is not ticked, months must be set up manually.

Months
EXO Business Analytics > Setup > Setup Months

The Sales Period Setup window defines the period Start and End dates within the selected financial year.
These periods are completely user-defined, but they cannot overlap one another.
Click the New button to establish the periods within the financial year.
Double-click on an existing period to edit it (or select a period and click the Edit button). The Period Name
can be changed to something more appropriate if necessary, and Start and End dates for the beginning and
end of the year can be changed.
The Delete button deletes the selected period, but only if there is no existing data for that period.
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Budget
EXO Business Analytics > Setup > Setup Budgets

The Budget Setup window lets you set up the budgets and margins for each period. The total of these
periods represents the budget for that financial year. You can set budgets and margins for each branch, or
for all branches at once.
Double-click on a period to edit the Value and Margin for that period.
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Day Plan
EXO Business Analytics > Setup > Setup Day Plan

The Period Day Plan Setup window is a day planner that determines workdays, and the weighting to be
applied to each workday. For example, a retail business will most likely have a heavy weighting to Saturday,
if a large amount of the week’s total sales are conducted on a Saturday.
Double-click on the WorkDay value for a day to toggle between “Yes” and “No”.
Click on the RunRate value for a day to enter its weighting.
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Running EXO Business Analytics from the Command Line
The EXO Business Analytics module, Analytics.exe, can be run from the command line in unattended
“snapshot” mode, launching and exiting at predetermined times, as specified by a scheduled task in
Windows.

Command Line Parameters
Parameter

Meaning

ConnectionName

A valid MYOB EXO Business database connection name. Required.

LoginID

A valid staff Login ID. If the ID contains spaces it must be enclosed in quote marks
(“ “). Required.

Password

The password for the supplied Login ID. Required.

/?

Displays a window listing all of these command line parameters. Optional.

/NOSAVE

Prevents the saving of the current connection to the connection history list.
Optional.

/M

Mode. /M=SNAPSHOT runs EXO Business Analytic in snapshot mode, meaning
that it closes as soon as it has run. Exceptions are logged in snapshot mode only.
Optional.

/TRANSDATE

Specifies a transaction date. Optional.

/L

Specify the name of the file to log to. Optional.

Example
Analytics Testdata ExoAdmin ExoAdmin /M=SNAPSHOT
/L=d:\EXOBusiness\Analytics\Analytics.LOG
Runs EXO Business Analytics in snapshot mode, logging on to the connection “Testdata” using the logon ID
“ExoAdmin” and password “ExoAdmin”. Log information is written to the file
d:\EXOBusiness\Analytics\Analytics.LOG.
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